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Abstract 

Introduction: One of the important challenges in studying the hydraulic, morphological and 

ecological behavior of rivers is to accurately determine the geometrical dimensions of river 

bed particles.  The information extracted from the grain size curve of river bed particles has 
many applications in the field of river engineering, such as modeling of sediment transport, 

changes in sediment deposition or river bed erosion, and changes in river morphology 

(Hasannejad Sharifi et al., 2015). Nowadays, despite the fact that determining the granularity 
of the bed particles and the boundaries of rivers is important, the removal of sediments from 

the natural environment leads to disturbing the sedimentary bed and causes changes in the 

river system (Sadeghi and Qara Mahmoudoli, 2013). Therefore, it is very important to use a 
method that can calculate the results of granulation with less cost and quickly. Image 

processing methods are known as new methods have been taken into consideration in order 

to increase rapidity and accuracy, along with the method of field measurement of 

granularity. 

Methodology: In this research, by examining the morphological and sedimentary conditions 

of the rivers of the Zanjan province, as well as the ease of access, Zanjanrud River was 
selected as the study area. Then three cross-sections for sampling with frame dimensions of 

20×20 cm were determined from the bed of Zanjanrud River and after photographing the 

surface of the samples, painting by spray paint in order to identify the surface grains, 
sampling was done from the determined sections. The samples were taken to the laboratory 

and the sieve test was performed. Then, in the laboratory environment, each of the samples 

was arranged in a metal frame with dimensions of 20×20 cm and was installed in a channel 
with a length of 8 meters and a width of 20 cm. By applying the conditions of stagnant water 

at three depths of 4, 8 and 12 cm and water flow with different depths and velocities, the 

samples were re-photographed and the grain size curve were obtained by Image J and 

Hydraulic Toolbox software. 

Results and discussion: Based on the results of Sieve, in sample A, almost 85% of the
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particles have a diameter equal to and less than 31.7 mm. In sample B, almost 85% of the 
particles passed through the sieve of 1.38 mm. In sample C, more than 97% of the particles 

passed through the 38.1 mm sieve. According to the classification system of the United 

States, the sediments of all three sections of Zanjanrud River are gravel. Also, according to 
the results, it can be seen that the standard deviation of the samples is less than 2, the 

uniformity coefficient is less than 4, and the sorting coefficient is less than 2, which shows 

that the examined samples are almost uniform.  In sample A, at depth of 8 cm, the average 
relative absolute error values were obtained similar to those at depth of 4 cm. In sample B, 

the average error value of the fine grains is the same as the coarse grains. The reason for this 

can be due to the low value of the standard deviation of this sample compared to the other 
two samples. The average error value at depth of 8 cm was found to be 14% for fine grains 

and 12% for coarse grains. In sample C, similar to sample A, the average error value in the 

fine grains is less compared to the coarse grains. The average relative error at depth of 8 cm 
was found to be 9% for fine grains and 14% for coarse grains. Results showed that Image J 

software has better performance than Hydraulic Toolbox software in determining the 

particles granulation curve of the Zanjanrud River. 

The effect of flow velocity and depth on the K values of the index diameter of 50% showed 

that at depth of 4 cm, the average values of K in samples A, B, and C are 1.01, 1.19, and 1.08, 

respectively. Also, at depth of 8 cm, the values of K for samples A, B, C are equal to 1.05, 
1.12, and 1.11, respectively, and at depth of 12 cm, there are equal to 1.08, 1.18, and 1.13, 

respectively. According to these results, it can be seen that the K values of sample A are 

lower than the other two samples in all three depths of 4, 8, and 12 cm. At depth of 8 cm, the 
K values of sample B at different velocities coincide approximately with those of sample C. 

Also, the K values of sample C at two depths of 4 and 12 cm are lower than the K values of 

sample B. The average K values of the 50% index diameter at three depths of 4, 8, and 12 of 
sample A are 1.01, 1.05, and 1.08, respectively (with an average value of 1.046); the mean K 

values of sample B are 1.19, 1.12 and 1.18 respectively (with an average value of 1.16) and 

also the mean K values of sample C are 1.08, 1.11 and 1.13 respectively (with an average 

value of 1.1) (with a total average of 1.1 for all three samples). 

Conclusion: In most of the hydraulic flow conditions, the granulation curve obtained by 

Image J software is close to the sieve granulation curve. In contrast, the Hydraulic Toolbox 
granulation curve is significantly different from the sieve curve and the curve of Image J 

software. The flow velocity and flow depth does not have a noticeable effect on the K values 

of the index diameter of 50%. 

Keywords: Image processing, Surface layer, Granulation curve, Shape factor, Image  J, 

Hydraulic Toolbox. 
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 www.jhyd.iha.irگاه نشریه هیدرولیک: وب      ⸙⸙⸙       01/07/1403، نقد و بررسی: 1402/ 07/06، پذیرش: 02/03/1402دریافت: 

رفتار هیدرولیکی، ریخت  :چکیده بررسی  رودخانهدر  اکولوژیکی  از چالششناسی و  زبری  ها یکی  ابعاد هندسی  تعیین دقیق  های مهم، 

با   یشن  یهابستر رودخانه یو شکل ذرات رسوبات سطح  یبنددانهنتایج بر  انیعمق و سرعت جر ریتاثهاست. در این تحقیق بستر رودخانه

پردازش تصو از روش  ابعاد قاب  ی گردید. سه مقطع جهت نمونهابیارز  ریاستفاده  با  زنجانرود  سانتی  20×20برداری  بستر رودخانه  از  متر 

بندی شد. در محیط آزمایشگاه، هر یک از  آوری و با روش الک دانهها جمع برداری از سطح رسوبات، رسوبات نمونهتعیین و پس از عکس

متر نصب شد. با اعمال شرایط آب  سانتی  20متر و عرض    8متر چیده و در کانالی به طول  سانتی  20× 20ها داخل قاب فلزی با ابعاد  نمونه

ها صورت گرفت و نتایج نمونهبرداری مجدد از  های مختلف، عکسمتر و جریان آب با عمق و سرعت سانتی  12و    8،  4ساکن در سه عمق  

نتایج منحنیپردازش گردید.    Hydraulic Toolboxو    Image Jافزارهای  توسط نرم  از نرم های دانهمقایسه  -افزارها نشانبندی حاصل 

نرم بهتر  عملکرد  نرم  Image Jافزار  دهنده  به  تاثیر  می  Hydraulic Toolboxافزار  نسبت  جریان  سرعت  و  عمق  نتایج،  مطابق  باشد. 

( ندارد، بطوریکه  K)ضریب    Image Jافزار  محسوسی روی نسبت مقادیر قطرهای شاخص منحنی الک به قطرهای شاخص حاصل از نرم 

بدست آمد. نتایج فاکتور شکل نشان داد از   1/1و  16/1، 046/1به ترتیب برابر با  Cو  A ،Bدر سه نمونه  %50در قطر شاخص  Kمیانگین 

ذرات بیضوی و در   % 22ذرات مستطیلی و    B  78%ذرات، بیضی شکل هستند. در نمونه   % 12ذرات مستطیلی و    A  88%دید قائم، در نمونه  

 ذرات، بیضی شکل هستند.  % 20ذرات مستطیلی و    C  80%نمونه  
 

 .IMAGE J , HYDRAULIC TOOLBOXافزار  رود، نرمشکل، زنجان سطحی، فاکتور  لایه  بندی،دانه  تصویر، منحنی پردازش: كلیدواژگان
 

 

 

 مقدمه -1
زنودگی   در  ای کننوده مهوم و تعیوین  ها هموواره نقوش رودخانه 

انود. تعیوین  داشته  سطحی، آب  مهم  منبع  عنوان یک ها به انسان 

هوای بسوتر از  رسووب هوا و  های رودخانه دقیق ابعاد و مشخصه 

آید. روش متوداول  شمار می ها به های رودخانه ترین مسئله مهم 

بندی خوا  روش الوک اسوت. بورای تعیوین  برای تعیین دانه 

های مصوالح  ها، نمونه اندازه توزیع ذرات بستر رودخانه یا آبراهه 

-شوند تا آزمون دانوه می آوری شده و به آزمایشگاه منتقل گرد 

  منحنووی   از   کووه   بنوودی بوور روی آنهووا انجووام گیوورد. اط عوواتی 

  کاربردهوای   شوود، موی   رودخانه استخراج   بستر   ذرات   بندی دانه 

انتقوال   سوازی مدل   ماننود   رودخانه   مهندسی   زمینه   در   فراوانی 

  بسوتر   فرسوایش   یوا   گوذاری رسووب   وضوعیت   تعیین   ها، رسوب 

  دارد   رودخانووه   شناسووی ریخووت   هووای تغییرپووذیری   و   رودخانووه 

 (Hassannejad Sharifi et al., 2016 .)   هوای ه محاسب طرفی    ز ا  

  شوکل و    زبوری انودازه    بوه   جریوان   و سرعت   رودخانه   اشل -دبی 

یعنووووی  هوووا  ویژگوووی   ایووون   دارد، کامووول    بسوووتگی   بسوووتر 
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  جریوان   در اثوور   بسووتر   شکل های اندازه زبری و  پذیری تغییور 

  عبوور  هنگوام  بوه  ویوژه بوه  اشل -دبی   رابطه ر  د   مهمی   تأثیر   آب 

مقابول    در   مقاوموت   یوک معادلوه   اشول -دبی   رابطه   .دارد   سیل 

  دبوی،  کوه صوورتی  در آب  عموق  تعیوین  برای  که  است  جریان 

  بووه ،  مشوخص باشود   بستر  مواد های ویژگی  شیب،  ، آبراه  شکل 

بنودی  تعیوین دانوه (. بنابراین  White et al., 2005)   رود می   کار 

برداشوت  اموا    بووده، ها با اهمیوت  رودخانه   م ی مصالح بستر و حر 

ها از محیط طبیعی منجر به بورهم زدن بسوتر رسووبی  رسوب 

آورد  وجوود مووی شوده و تغییرهوایی را در سوامانه رودخانوه بوه 

 (Sadeghi and Gharamahmudli, 2013  از سویی دیگور .)  بوه

  انتقوال  برداری دستی از رودخانوه، گزاف نمونه   های نه ی علت هز 

  هوای ش ی مربوو  بوه آزموا   هوای نه ی و هز   شگاه ی ها به آزما نمونه 

هوای مهندسوان مشواور از آن  شورکت   بیشوتر مکانیک خا ،  

  هوای نوه ی حاضر به قبول هز   ان ی کارفرما   و   کنند پوشی می چشم 

  نوه ی نیستند. لذا اهمیت استفاده از روشی کوه بوا هز   شگاه ی آزما 

بنودی را محاسوبه  از دانه  ناشی  ج ی بتواند نتا   بالا کمتر و سرعت  

 . ( Zarei et al., 2019)   اهمیت است  با کند، بسیار 

های پردازش تصوویر روش جدیودی اسوت کوه در کنوار  ش رو 

بندی به منظور افزایش سرعت و  گیری میدانی دانه روش اندازه 

بورداری از مصوالح  در روش نمونه  دقت به آن توجه شده است. 

ها از عموق بسوتر رودخانوه  طور معمول نمونه سطحی بستر، به 

طوور عموده بوا ذرات  شوند و اندازه این مصالح بوه برداشت می 

انود، متفواوت هسوتند،  سطحی بستر که بوا جریوان در تمواس 

بنودی لایوه سوطحی  نتیجه درسوتی از دانوه   توان بنابراین نمی 

مصالح بستر که با جریان رودخانه در تماس مستقیم هسوتند،  

ونگی  چگووو  1شوووکل    . (Bunte and Abt, 2001)گرفوووت  

چگونگی نمونه برداری سوطحی   2برداری عمقی و شکل نمونه 

 Management and Planningدهووود  را نشوووان موووی 

Organization of Iran, 2007) ). 

  پوردازش   ای روش فنوی برمبنو  خوا    بنودی دانه   های برتری   از 

  آزمووایش   انجووام   ی هزینووه   و   زمووان   در   جووویی صوورفه   تصووویر، 

  از   دقیوق   اط عوات   و ارایوه   معموول   روش   بوه   نسبت   بندی دانه 

  بزرگتور،   هوای منطقوه   به   ها نمونه   تعمیم   و   کوچک   های منطقه 

  و   مکوانی   توزیع   تر آسان   تعیین  و  گیری، تحلیل شناسایی، اندازه 

  از   تووان می   طرفی   از .  ( Penders, 2010کرد )   اشاره   ذرات   زمانی 

  بوه   آسویب   بودون   ناپوذیر دسترس   های منطقه   در   رسوبی   ذرات 

  وجوود،   ایون   با .  کرد   تصویربرداری   آسانی   بررسی به   مورد   سطح 

  دقوت  و  رودخانوه   بسوتر   هوای رسووب   از   تصویربرداری   کیفیت 

  و  هیودرولیکی  هوای تواثیر عامول   تحوت   آنهوا   تصوویر   پردازش 

  شکسوت   پدیده   و   خورشید   تابش   شدت :  مانند   مختلف   محیطی 

  جریوان(،   عموق   هوای تغییرپوذیری   از   )ناشوی   آب   عمق   در   نور 

  جریوان(،   سورعت   هوای تغییرپذیری   از   )ناشی  آب  سطح  ت طم 

 . باشد می   عکاسی  پایه   سه   به   آب  جریان   از  وارده  نیروی 

 
Fig. 1 Deep sampling method 

 برداری عمقیچگونگی نمونه 1شکل 

  
Fig. 2 Surface sampling method 

 برداری سطحیچگونگی نمونه 2شکل 

 

  دیجیتوال،   عکاسوی   هوای دوربین   ترویج   و   ها فناوری   با پیشرفت 

  و تحلیول   تجزیوه   بورای   مختلفوی   افزارهوای نورم   و   هوا الگوریتم 

  دیجیتوالی   تصوویرهای   از   اسوتفاده   بوا   بسوتر   اط عات   خودکار 

انود. البتوه رعایوت  شوده  ارائوه  هوا  آبراهه  بستر   از   شده   دریافت 

های مهوم  های حاکم بر روش پردازش تصویر از عامل استاندارد 

باشود. از  سنجی این روش با روش متداول الوک موی در صحت 

  جداسوازی قودرت    مانند   هایی عامل توان به  این استانداردها می 

دوربین، اندازه قاب تصویر و الگووریتم موورد اسوتفاده، فاصوله  

دوربین تا بسوتر و انودازه ذرات بسوتر اشواره کورد. هم نوین  

شرایط نور یکسان )زمان عکاسی در فاصوله ههور، وجوود نوور  

سومان( از  متعادل، نبود سایه و در صورت امکان ابوری بوودن آ 
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 ,.Hassannejad Sharifi et alهای این روش است ) محدودیت 

2016; Sadeghi and Gharamahmudli, 2013; Azizian 

and Samadi, 2019 .) 

 

 هامنبعاشاره به   -1-1
ای از بستر رودخانه بورای  برداری شبکه در معرفی روش عکس   

  بررسوی دانوه ) بنودی لایوه محوافس بسوتر درشوت تعیین دانوه 

یوک    هوای نقطوه برداری از فوراز  موردی: رودخانه کرج(، عکس 

نشوان داد کوه روش    دسوت آموده بوه شبکه انجام شود. نتوایج  

بورداری  پردازش تصویر روشی سوریع و بودون نیواز بوه نمونوه 

 . (Abd Sharif Esfahani et al., 2006)  باشد می 

در ارتبا  با استفاده از روش پوردازش تصوویر، الگووریتمی در  

افووزار متلووب ایجوواد شوود کووه توانووایی اسووتخراج  محوویط نوورم 

هندسی مصالح سطحی بستر رودخانوه را از روی    های مشخصه 

تهیه شده دارد. نتایج نشان داد که الگوریتم توسعه    تصویرهای 

  هووای بررسووی توووان بووا دقووت مناسووب در  داده شووده را مووی 

شناسووی رودخانووه و فرسووایش رسوووب  هیوودرولیکی، ریخووت 

 (. Azizian et al., 2013)  کرد استفاده  

های بوا بسوتر  توزیع دانه بندی ذرات رودخانه   برآورد در زمینه  

های الگوریتم حوضه آبخیز و الگووریتم بازسوازی  شنی از روش 

  بوازده افزار متلب استفاده شد. نتایج نشان داد که  تصویر در نرم 

درصود و در    96/ 3قطر ذرات در مدل بازسوازی تصوویر    برآورد 

  گویوای درصود بوود. ایون امور    66مدل الگوریتم حوضه آبخیز  

بازسوازی تصوویر در مقابول الگووریتم    پالایشوگر برتری نسبی  

توانوود کارآموودترین و  حوضووه آبخیووز بووود و ایوون روش مووی 

های سنتی، مانند الوک  ترین روش برای جایگزینی روش سریع 

 (. Payesteh et al., 2018کردن شود ) 

هوای مختلوف پوردازش  در تحقیقی به بررسی کارایی الگوریتم 

در    GIASو    Hydraulic Tool Box و    Image Jتصوویر شوامل 

بنوودی در  تعیوین زبووری هیوودرویکی بووه کمووک منحنووی دانووه 

عملکورد   سوه ی بوا مقا های بستر شونی پرداختوه شود.  رودخانه 

Image J     وHydraulic Tool Box    وBasegrain   گیری  جه ی نت

در    ی عملکورد بهتور   Hydraulic Tool Box Jافوزار  که نرم شد  

 Zarei et)   دارد   ی شون   ی بسوترها   ی دانه بنود   ی استخراج منحن 

al., 2019 ) .  

  دو   در   هوا آبراهوه   سوطحی   مصالح   دانه بندی   بررسی دیگری در  

تصویر )رودخانه سویرج کرموان(   پردازش  با  تر  و   خشک   حالت 

 و    Image Jافزارهووای . مقایسووه عملکوورد نوورم شوود تعیووین  

Hydraulic Tool Box    وGIAS   افزار  نشان داد که نرمImage 

J    عملکوورد بهتووری در اسووتخراج منحنووی دانووه بنوودی دارد

 (Azizian and Samadi, 2019 .) 

دانه  درشوت  هوای بنودی رسووب برآورد منحنوی دانه به منظور  

یکپارچوه اسوتفاده شود.  تصوویربرداری    سامانه یک  سطحی از  

بوا  در حالوت خشوک و تور    رودخانوه   هوای پردازش رسووووب 

افووزار  مقایسووووه نتووایج نرم گرفووت.  انجووام   ImageJ افووزار نرم 

ImageJ    افوزار بوود  نشان دهنده دقت خوب نورم   با روش الک

 (Tabee et al., 2023 .) 

نمونه   39بستر، پس از بررسی  های بندی رسوب در تعیین دانه 

گیووری و تصووویربرداری شووده )بووا اسووتفاده از پووردازش  انوودازه 

شود    گیری تصویر(، در بستر سه رودخانه در انگلیس این نتیجه 

درصود دارای دقوت    95که پردازش تصویر در سوطح اعتمواد  

 (. Graham et al., 2005) مناسبی است  

دلتای رودخانه الوا بوا اسوتفاده از یوک    های ساحل پژوهشی در  

دانه  درشت   های تعیین ابعاد رسوب   برای روش خود همبستگی  

بسوتر    هوای های تهیه شوده از رسووب از طریق پردازش عکس 

انجام شود. نتوایج نشوان داد خطوای روش موورد اسوتفاده در  

متور  میلوی   200توا    1ذرات در محدوده    میانگین برآورد اندازه  

 (. Warrick et al., 2009باشد ) درصد می   14برابر 

ذرات رسوبی بوا اسوتفاده یوک    میانگین به منظور تعیین اندازه  

هوای دارای شویب  روش خودکار پردازش تصوویر در رودخانوه 

درصود مووارد، نتوایج   85کوه در  شود زیاد انجام شد، گزارش  

درصود بوا نتوایج روش الوک    50  بیشینه روش پردازش تصویر  

 . (Penders, 2010)اخت ف داشتند 

یک روش مبتنی بر پردازش تصویرهای دیجیتالی در   کارگیری به 

بنودی  مقابل روش شمارش ذرات به منظور تعیین منحنی دانوه 

ذرات سنگی نشان داد که روش مبتنی بر تصویرهای دیجیتوالی  

طور قابل قبولی در پنج ناحیه از شش ناحیه مورد بررسی نتایج  به 

 (. Strom et al., 2010خوبی نشان داد ) 

  روش فنوی در رودخانه راسیل با بستر شونی واقوع در موالزی،  

بررسوی    Image Jافوزار  تعیین خودکار اندازه ذرات با کمک نرم 

بیوانگر توانوایی خووب  (. نتوایج  Sulaiman et al., 2014)   شود 

 در دامنه ذرات ریز بود.   ویژه به افزار نرم 
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  هوا بنودی رسووب تعیین دانه   برای کاربرد روش پردازش تصویر  

 Diکیلومتری رودخانه تسکو واقع در ایتالیا ارزیابی )   3در بازه  

Francesco et al., 2016 افوزار  ( و گوزارش شود نورمImage J  

 دارد. اندازه ذرات  ع ی توز  ن یی در تع  ی خوب   عملکرد 

  هوای بررسوی توجه به جدید بودن موضوع پردازش تصوویر،    با 

  هوای هندسوی رسووب   های ه تعیین مشخص   زمینه گسترده در  

  هوای پرسوش و    ها ابهام سطحی بستر رودخانه صورت نگرفته و  

قابلیوت اسوتفاده ایون    ویژه به اجرا و    چگونگی زیادی در زمینه  

نتووایج  هووا وجووود دارد. موورور  روش در بسووتر انووواع رودخانووه 

دهد تاکنون تحقیقوی در زمینوه  پیشین نشان می   های بررسی 

آزمایشوگاهی    آبراهه تاثیر عمق و سرعت جریان در رودخانه یا  

در  برروی نتایج پردازش تصوویر ارائوه نشوده اسوت. از طرفوی  

رودخانووه، همووواره توو ش    ی مهندسوو  هووای بررسووی و ارزیووابی 

تا حد ممکون    ی شگاه ی آزما   تحقیقات است که    ن ی برا   ان مهندس 

از موضووع    ی د توا در  بهتور ن باشو ک یونزد  ی دان ی م  ط ی به شرا 

هوای میودانی  گیوری با توجه به اینکه امکان اندازه .  شود   کسب 

  نبوود رود فراهم نبود ) عمق و سرعت جریان در رودخانه زنجان 

گیوری  آلودگی جریان آب، نبود تجهیوزات انودازه جریان یا گل 

زلال در    ان یووجر   ط ی شوورا   شوود   ی سووع   پووژوهش و...(، در ایوون  

  هوای هوایی از رسووب و بوا تهیوه نمونوه   شوود ایجاد    شگاه ی آزما 

و    Image Jافووزار  نوورم   رود، ارزیووابی سووطحی بسووتر زنجووان 

Hydraulic Tool Box  ی بنوود دانووه   ی در اسووتخراج منحنوو  

  ان یومختلف عمق و سورعت جر   ط ی در شرا   ی سطح   های رسوب 

 در شرایط آزمایشگاهی انجام گرفت. آب زلال  

 

 هامواد و روش -2

 بررسی معرفی رودخانه مورد   -1-2
هوای اسوتان  و رسوبی رودخانه  شناسی ریخت با بررسی شرایط 

رود به عنووان  رود واقع در حوضه زنجان زنجان، رودخانه زنجان 

انتخاب شد. با انجام بازدیودهای میودانی    بررسی رودخانه مورد  

مناسب برای تعیوین   های مقطع از مسیر رودخانه، بازه طولی و 

بورداری  برای نمونوه  هایی مقطع . شد بندی مصالح مشخص دانه 

انتخاب شدند که در مسیر اصلی رودخانه با شویب یکنواخوت  

طولی و عرضی قرار داشته و دارای بستر شنی، قابول برداشوت  

ولای باشوند. از طرفوی یکنوواختی  هرگونه لجن و گول   بدون و  

بندی در مقطع عرضی تا حد امکان موجوب دقیوق بوودن  دانه 

ی تقریبوا نویم کیلوومتری در طوول  خواهد بود. بازه   ها ه محاسب 

موقعیوووت جغرافیوووایی   رود از حدفاصووول رودخانوووه زنجوووان 

E  ″32  ′08  º48    وN  ″24  ′55    º36    توواE  ″22  ′08  º48    و

N  ″33  ′55  º36   بورداری در نظور  به عنووان محودوده نمونوه

 گرفته شد. 

 

 ه برداری میدانی ننمو  روش  -2-2
متور از    200مقطع با فاصله طولی تقریبوی    3برداری در  نمونه 

تصوادفی بوا  صوورت  ه مقطع ب   نخستین یکدیگر صورت گرفت. ) 

های مطرح شده انتخاب شود(. بورای هور مقطوع قوابی  ویژگی 

متور در نظور گرفتوه شود.  سانتی   20× 20مربعی شکل به ابعاد  

مرحلووه    نخسووتین بوورداری،  هووای نمونووه پووس از تعیووین محوول 

از   تصوویرها باشود. بورای تهیوه هوا موی تصویربرداری از نمونوه 

  24مکوانی    جداسوازی بوا قودرت    D7200دوربین نیکون مدل  

تهیوه    بورای اسوت    یوادآوری مگاپیکسل استفاده شد. لازم بوه  

بهترین تصویر برای پردازش، بایستی دوربین نسبت به سوطح  

تصویربرداری قائم باشد. بدین منظور از دوربین مجهز به توراز،  

حوذف   بورای پایه با قابلیت تنظیم ارتفواع از سوطح زموین سه 

خطای ناشی از لرزش دست و سایه انداخت روی زمین و قاب  

 استفاده شد. 

موجوود در پیموایش میودانی مسویر    هوای مسوئله با توجه بوه  

  بورای   رودخانه و حمل تجهیزات تصویربرداری مورد نیواز، و در 

و دقت بالای تصویربرداری با بستر رودخانه، دوربوین    آسانگری 

پایوه ثابوت و قابول حمول  ی افقی فلوزی و سوه روی یک میله 

مووردنظر در قواب    هوای مقطوع . تصوویربرداری از  شود مستقر  

متری تا سطح بستر و با حالت  1متری از فاصله سانتی   20× 20

صوورت پوذیرفت.    تصوویربرداری   سطح   بر   ن ی دورب بودن  عمود  

ی روز )موابین سواعت  تصویربرداری در شرایط آفتابی در نیمه 

ای  صوورت مسوتقیم تابیوده و سوایه ه ههر که آفتاب ب   13-11

ایجوواد نشووده باشوود( صووورت گرفووت. پووس از تصووویربرداری،  

صوورت  ه هوا بورنگ شدند تا برداشوت نمونوه   با پاشش ها نمونه 

سطحی صورت گرفته و با دقت بیشتری بورای آزموایش الوک  

آوری  گورد ها  کیسه   درون . ذرات رسوبی با دقت  شوند آوری  گرد 

شود و بوه منظوور انجوام آزموایش الوک بوه آزمایشوگاه گووروه  

شورایط    3. شوکل  شود مهندسی آب دانشوگاه زنجوان منتقول  

 دهد. برداری را نمایش می موجود برای نمونه 
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Fig. 3 Sampling cross section of Zanjanrud river 

 رود ی زنجانبرداری شده رودخانه مقطع نمونه  3شکل 

 های مورد استفادهروشمعرفی    -3-2

   Image Jمدل    -1-3-2

 ImageJ (Image Processing and Analysis inافوزار نرم

Java)    اسوت و   تصوویرها  تجزیوهبورای    توانمنودیک برنامه

افزار توسط موسسه ملوی کاربردهای مختلفی دارد. این نرم

بهداشت ایالات متحده آمریکا طراحی شوده اسوت کوه بور 

روی پلتفووورم جوواوا نوشووته شووده و اسووتفاده بسوویاری در 

افزار کاربردهای فراوانی تصویربرداری پزشکی دارد. این نرم

ذرات و انودازه   شوماردارد از جمله: محاسبه درصد فازهوا،  

ذرات، در زمین شناسی به منظور تعیین مساحت، محویط، 

بورازش و  . بورایهندسی  هایهمشخص  دیگرقطر، کرویت و  

استخراج دقیق مساحت، محیط، قطر کوچک و قطر بوزر  

 چندی  هایاز دستور  تصویرهاهای موجود در  و کرویت دانه

افزار پردازش تصویر توسط نرم  هایمرحلهشود.  استفاده می

Image J صورت زیر است:به 
مقیاس دهی تصویر: با اسوتفاده از ابوزار خوط بوه   -الف

دهی، کاربر طولی مشخص را کشیده و اندازه منظور مقیاس

کند. به منظور تعیوین دقیوق خوط مقیواس، آن را وارد می

 (.  Analyze -> Set Scaleشود )قطر قاب در نظر گرفته می

 Imageبیتی ) 8تبدیل تصویر به تصویر خاکستری   -ب

->Type->8-Bit ) 

به برطورف   پالایشگر: این  Median  پالایشگراعمال    -پ

ها از روی ذرات موجود در تصویر کموک کردن خش و لکه

  (.Process->Filters->Medianکند )می

ای: در این مرحلوه حدی یا آستانه  هایناجیهایجاد    -ت

شود. در واقوع در تصوویر تصویر به حالت باینری تبدیل می

خوورد  یکوی مربوو  بوه ذرات و تنها دو رنگ به چشم می

های سیاه رنگ دیگری مربو  به پس زمینه. در تصویر لکه

ها به رنگ سوفید نموایش ی نمونهمربو  به ذرات و زمینه

  (.Image->Adjust->Thresholdشود )داده می

استفاده از عملگر پخش: برنامه به صورت خودکوار   -ث

ذراتی را که در تماس با یکدیگرند یا همپوشوانی دارنود، از 

کند. بدین ترتیب که پس از تشکیل نقشوه یکدیگر جدا می

اند، را که دچار خوردگی شده  هایینقطهاقلیدسی، دورترین  

را توا جوای ممکون  هوانقطوهیابد  سپس هر یک از این می

 (Process->Binary->Watershedدهد )اتساع می

ها بر ذرات: برنامه بوه ها یا چند ضلعیبرازش بیضی  -ج

ها را بر ذرات موجوود بیضیها و  ترتیب بهترین چند ضلعی

در ایون  کنود.بیتوی، محویط موی 8در یک تصویر بواینری 

مرحله، چون ذرات تشوکیل دهنوده از نووع شون هسوتند، 

پیکسل در نظور گرفتوه   240ذره برابر با    اندازهکوچکترین  

 یهموه(. بودین منظوور Damadipour et al., 2019شود )

پوردازش   هوایهپیکسل از محاسوب  240تر از  ذرات کوچک

 (.Analyze->Set Measurementsشوند )تصویر حذف می

ابعوواد  تجزیووهنتووایج  دریافووتدر نهایووت امکووان  -ح

شوکل هندسوی بورازش داده شوده در   مبنایها برسنگدانه

بنودی را توان منحنی دانهدست آمده و میهب  محیط اکسل

 (. Analyze-> Analyze Particlesرسم کرد )

 

 Hydraulic Toolboxمدل  -2-3-2
Hydraulic Toolbox ای است که شامل مجموعه ای برنامه

و تجزیه   هاهدر زمینه محاسب  شدنیهمستقل از ابزار محاسب

باشد. این و تحلیل هیدرولیکی، هیدرولوژیکی و طراحی می

بووه  Aquaveo توسووط شوورکت 2014افووزار در سووال نوورم

سفارش اداره بزرگراه های فدرال وزارت راه و ترابری ایالات 

ابووزار تخصصووی آن  متحووده امریکووا توسووعه یافتووه اسووت. 

هوا، آبراهوهروش منطقی هیدرولوژیکی،    تجزیهاند از  عبارت

و... ایون   هوابنودی رسووبها، دانوهسرریزها، آبشستگی پل

 هوایهدهود توا محاسوببرنامه به کواربر ایون امکوان را موی

هیدرولیکی را در یک فایل پروژه انجام داده و ذخیره کنود، 

را تجزیووه و تحلیوول و نمودارهووا و  فوورضپوویشین چنوود

. در کنودهایی از این تجزیه و تحلیل ها را استخراج گزارش

هوا بنودی رسووبافزار الگوریتمی برای تعیین دانوهاین نرم

ها وجود دارد که با دریافت تصویر دیجیتالی از بستر آبراهه
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d15, d5d ,50 ,… ,بندی و نیز قطرهای تواند منحنی دانهمی

100d کندتهیه  سرعتبه دهنده بستر راذرات تشیکل. 
 :اند ازترتیب عبارتپردازش تصویر به هایمرحله

الف( تعیین طول خط مقیاس در تصوویر )ایون طوول بایود 

 (.شودبرداری از محل تعیین حین عکس

 ب( تبدیل تصویر رنگی به تصویر خاکستری هشت بیتی

 پالایشوگر)این    Median  پالایشگر( عبور دادن تصویر از  پ

هوا از روی ذرات موجوود در به برطرف کردن خوش و لکوه

 (.کندتصویر کمک می

 ( اعمال عملگر پس زمینهت

ای کوه تصوویر را بوه حدی یا آسوتانه  هایناحیه( ایجاد  ث

کند. در این حالت در تصوویر تنهوا حالت باینری تبدیل می

چشم خواهد خورد که یکی مربوو  بوه ذرات و دو رنگ به  

 شود.ها میزمینه آندیگری مربو  به پس

هندسوی   هوایهگور اسوتخراج مشخصو( استفاده از عملج

( که به کموک آن ذراتوی کوه در Watersheddingتصویر )

پوشوانی دارنود، بوه صوورت تماس با یکدیگر بوده و یا هوم

 شوند.خودکار از یکدیگر جدا می

 با پردازش، فرآیند تکمیل برای ها بر ذرات( برازش بیضیچ

 هوا،بیضی از یک هر (b) میانگینو  (a) بزر  قطر محاسبه

 .شد محاسبه تصویر در منفرد موجود ذرات یهمه مساحت

 آنجا از و باشدمی ذرات تصویر دوبعدی شامل تنها نتایج این

 خوود بوزر  و میانگینقطرهای  با ذرات طور معمولبه که

 قائم راستای در (c) کوچک قطر و گیرندمی قرار بستر روی

 منحنوی از آموده دسوت بوه معوادل قطر لذا شود،می واقع

 و میوانگین قطرهای میانگین از ناشی تنها تصویر، پردازش

 روش ایون در ذرات اندازه توزیع منحنی و بوده ذرات بزر 

 داشت.  خواهد اخت ف الک با بندی دانه منحنی با

از   ناشوی  اولیه  هایمنحنی  اص ح  منظور  افزار بهاین نرمدر  

 هوایمنحنی  بین  مقایسه  امکان  ایجاد  نیز  و  تصویر  پردازش

 تصوویر،  پوردازش  و  الوک  بوا  بنودیدانه  روش  دو  به  مربو 

کوه   شوودمی  استفاده  تصحیح  ضریب  از یک  طور معمولبه

 باشد.  می 5/2افزار عدد  فرض نرمپیش

 

 آزمایشگاهشرح كار   -4-2
رود، در های برداشت شوده از بسوتر رودخانوه زنجواننمونه

آوری شده و به آزمایشوگاه گوروه گردهای جدا از هم  کیسه

بنودی مهندسی آب دانشگاه زنجان منتقل شد. پس از دانه

تصوویری کوه از بسوتر رودخانوه   برابرها  توسط الک، نمونه

برداشت شوده بوود، درون یوک جعبوه گوالوانیزه بوه ابعواد 

متور چیوده شود. بوه سوانتی  2متر با عموق  سانتی  20×20

 تصوویرهایهوا، چواپ رنگوی  منظور تدقیق چیدمان نمونه

ها . به منظور قرارگیری دقیق سنگشدبستر رودخانه تهیه  

به همان شکل موجود در رودخانه، از ماسه به عنوان خا  

ی قاب به همراه نمونه  4پر کننده بستر استفاده شد. شکل  

دهود. برداری برای پردازش تصویر را نمایش میروش نمونه

متر، عورض   8به طول    ایآبراههدر آزمایشگاه، نمونه درون  

 سوامانهمتور کوه دارای  سوانتی  30متر و ارتفواع  سانتی  20

چوورخش آب و شوویب پووذیر بووود، قوورار گرفووت. سووپس 

 هوایمرحلههای مورد نظر اجرا و در هر کدام از  فرضپیش

آزمایشوگاهی   آبراهوهتصویربرداری صورت گرفوت. تصوویر  

بوه هموراه   آبراهوه  کلویمورد اسوتفاده و هم نوین نموای  

نشان داده شده است. روند کوار   5جرئیات و ابعاد در شکل  

نمونه برداشت شده از رودخانه به   3در آزمایشگاه برای هر  

انجام کوار در اداموه تشوریح   هایمرحلهیک صورت بوده و  

هر نمونوه   درون  هاپس از چیدن رسوب  آغازشده است. در  

 قرار داده شد. آبراهه درون، نمونه (6شکل )جعبه گالوانیزه 

های مختلف( با استفاده برای حالت اول )آب ساکن با عمق

برقرار کورده   آبراههاز شیر فلکه، جریان آب را به آرامی در  

، 4هوای ، آب ساکن با عمقآبراهه و با بستن دری ه انتهایی

هووا و از هوور یووک از حالووت شوودمتوور برقوورار سووانتی 12، 8

هوای بعودی )عموق و تصویربرداری انجام شد. برای حالوت

های مختلف( با باز کردن شیر فلکه و تنظیم دری ه سرعت

 4. در عموق شودانتهایی، عمق و سرعت مورد نظر تنظویم  

 مقوداری انتهوایی متر با افزایش دبی و تنظیم دری هسانتی

و پس از از   شدهای مختلف برای همان عمق برقرار  سرعت

موجوود در سوطح آب، تصوویر بورداری   آشفتگیبین رفتن  

اسوت بوه  یوادآوریبرای هر حالت صورت گرفوت. لازم بوه 

برقراری شرایط تصویربرداری یکسان در آزمایشوگاه   منظور

 1ی  و فاصوله  تصویرهاسایه در    نبودو رودخانه )نور ثابت و  

دسوت(، از نداشوتن  متری دوربین تا سطح ذرات و لورزش  

یک چهارپایه تاشو به منظوور توامین ارتفواع موورد نیواز و 

تصوویر  3هوا افزایش دقت استفاده شد. از هر یک از نمونوه

 برداشت شد، تا خطای ناشی از ت طم سطح آب یا لغزش 
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Fig. 4 Frame sample with sampling method 

 برداری همراه روش نمونهی قاب به  نمونه 4شکل 

 
a) The image of the laboratory model used in the research 

(a  تصویری از مدل آزمایشگاهی مورد استفاده در پژوهش 

 

 
b) Longitudinal profile  

(b  دید از   کلینمای)جانب )پروفیل طولی  

 

 
 

c) Plan  

(c  دید از بالا کلینمای   )پ ن( 

Fig. 5 Actual image (a), the image of the laboratory model used in the research (b), longitudinal profile plan (c) 
 مورد استفاده در پژوهش (  c( و دید از بالای آبراهه )b(، نمای کلی دید از جانب )aتصویر واقعی ) 5شکل 
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  a) Natural river bed          b) Printed color image         c) Box with sand bed          d) Arrangement inside box 

  d درون جعبه  ( چیدمان       cای     ( جعبه با بستر ماسه              b     تصویر رنگی چاپ شده )    a تصویر بستر طبیعی رودخانه ) 

Fig. 6 The steps of arranging sediments inside the galvanized box 

 ها درون جعبه گالوانیزه های چیدمان رسوبمرحله  6شکل 

 

دست کاهش پیودا کنود. در نهایوت تصوویری کوه وضووح 

. هموین شدبیشتری داشت به عنوان تصویر اصلی پردازش  

. در هور شودمتور نیوز انجوام  سانتی  12و    8کار برای عمق  

سورعت مختلوف(   5الوی    4دبوی )  5الوی    4  شمارعمق به  

هوای از آزموایش  ناشوی  تصوویرهایایجاد شد. پس از تهیه  

هوا آزموایش  دوبارهیک نمونه، اقدام به تغییر نمونه و انجام  

 شد.

لیتر بر ثانیوه،  1-12ها، دبی در محدوده آزمایش  یهمهدر  

 میوانگینو سورعت    65/0تا    08/0ی  عدد فرود در محدوده

متور بور ثانیوه بوود. بوه   5/0تا    08/0ی  جریان در محدوده

 هواشوکلدر ارائه نتایج و اختصار نویسی،    آسانگریمنظور  

. در هر نمونوه، حورف انگلیسوی اول، بیوانگر شدگذاری  نام

متر دوم عمق جریان برحسب سانتی  فراسنجهسری نمونه،  

باشد. به عنووان شماره دبی جریان میسوم نیز    فراسنجهو  

 4به ازای حالوت آب سواکن در عموق    Aی  مثال در نمونه

، 06/2،  1/1متر و حالت جریان آب با مقدارهای دبی  سانتی

لیتوور بوور ثانیووه در همووان عمووق بووه ترتیووب  16/4و  12/3

-A-04-00 ،A-04-01 ،A-04-02 ،Aصووورت گووذاری بهنام

سپس با توجه بوه روش   .صورت گرفت  A-04-04و    04-03

افزارهای مورد بررسوی، پوردازش تصوویر کار هر یک از نرم

افزارها انجام شد. پس از بدست ی تصویرها در این نرمهمه

ندی رسوم شود. سوپس منحنوی بآمدن نتایج، منحنی دانه

افزارها با منحنوی ناشوی از بندی ناشی از هر یک از نرمدانه

 Kالک مقایسه شد و بورای هور یوک از تصوویرها، ضوریب  

( محاسووبه شوود و 85d, 50d, 35d, 15dقطرهووای شوواخص )

به ازای عموق جریوان و   Kهای ضریب  منحنی تغییرپذیری

بورای  Kضوریب  1سرعت، در هر نمونه ترسیم شد. رابطوه 

 باشد.صورت زیر میبه idقطر شاخص  

(1) i s

i cal

d
K

d

−

−

=

( 85d, 50d, 35d, 15dقطرهای شاخص ) s-idکه در این رابطه،  

قطرهای شاخص بدسوت   cal-idبدست آمده از منحنی الک،  

باشود. افزار پردازش تصویر مویآمده از منحنی ناشی از نرم

تور باشود، دقوت نزدیوک  1هر چه مقودار ایون ضوریب بوه  

پردازش تصویر بالاتر خواهد بود. شایان یادآوری است برای 

افوزار ( نورمRAEمحاسبه مقدارهای خطای مطلق نسوبی )

Image J  وHydraulic Toolbox  در بوورآورد قطرهووای

 شاخص منحنی الک، از رابطه زیر استفاده شد.

(2) 100
− −

−

=
−


i s i cal

i s

d d
Relative Absolute Error

d

مقوودارهای مشوواهداتی قطرهووای  s-idکووه در ایوون رابطووه  

مقودارهای  cal-id( ناشی از الک، 85d, 50d, 35d, 15dشاخص )

( ناشوی 85d, 50d, 35d, 15dشدنی قطرهای شاخص )محاسبه

 باشند.  افزار میاز نرم

برای محاسبه عامل شکل ذرات، تصویربرداری دو بعودی از 

تضاد رنگ موجوود  مبنایبر پس از آنرفته، نمونه صورت گ

شود. ی سنگ، ابعاد سنگ محاسبه میزمینه و لبهبین پس

مساحت و محیط و کرویوت ذرات   مقدارهایپس از تعیین  

، با توجه به الگوریتم استفاده شده Image Jافزار توسط نرم

، درصود شوکل ذرات Damadipour et al. (2019)توسوط 

 فراسونجهبوا درنظور گورفتن دو    آنوان.  شدتعیین و تفسیر  

ERS (Equivalent Rectangle Sides و )EEA 
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(Equivalent Ellipse Axises ،)شکل  عاملA/2P  را بورای

ی پیشونهاد و گوزارش کردنود دو بعود  یتصویرها  پردازش

انودازه   عیتوز  بهتر  برآوردمنجر به    فراسنجه  نیااستفاده از  

نسوبت مربوع محویط ذره بوه . بدین ترتیوب  شودیم  ذرات

( محاسووبه شوود و بووا توجووه بووه الگووورتیم A/2Pمسوواحت )

پیشنهادی، شکل ذره اعم از مربع، مستطیل یا کره تعیوین 

 .  شد

 

 نتایج و بحث -3
 Cو  A ،Bبندی الک مربو  به نمونوه منحنی دانه 7 شکل

متور میلوی  1/38از قطور    Aدهد. ذرات نمونه  را نمایش می

ذرات قطری برابر و کمتور   %85  نزدیک بهتر بوده و  کوچک

 75/4متر دارند. درصد عبوری ذرات از الوک  میلی  7/31از  

ذرات از   یهموه،  Bاسوت، در نمونوه    %5متر کمتر از  میلی

ذرات   %85  نزدیک بهتر بوده و  متر کوچکمیلی  4/44الک  

اند. درصد وزنوی رد شوده متر عبور کردهمیلی  1/38از الک  

، کول Cاست. در نمونوه  %5متر کمتر از میلی  76/4از الک  

 %97تر بووده و بوالای  کوچک  مترمیلی  4/44ذرات از الک  

اند. درصود عبووری متر عبور کردهمیلی  1/38ذرات از الک  

 مبنوایاسوت. بر  %5متر کمتور از  میلی  75/4ذرات از الک  

هر سه مقطوع   هایمتحد، رسوبایالات  بندی  طبقه  سامانه

رود از نووع شون هسوتند. بوا توجوه بوه نتوایج بستر زنجان

، 2هوا کمتور از  شود که انحوراف معیوار نمونوهمشاهده می

و ضریب جورشدگی کمتور از   4ضریب یکنواختی کمتر از  

هوای موورد بررسوی دهود نمونوهباشد که نشوان مویمی  2

 یکنواخت هستند.  تاحدودی

 
Fig. 7 Sieve granulation curve of samples A, B, C 

 A, B , Cبندی الک نمونه  منحنی دانه 7شکل 

و  Image jافههرار نههر ی نتههایج مقایسههه -1-3

Hydraulic Toolbox الک بر مبنای نتایج 

 افزارهوایاز نورم  ناشویبنودی  نتایج منحنوی دانوه  8شکل  

Hydraulic Toolbox افوزار و نورمImage J  در مقایسوه بوا

بورای   Cو    Bو    Aهوای  از آزمون الک نمونوه  ناشیمنحنی  

متر و شرایط جریوان سانتی  8شرایط هیدرولیکی عمق آب  

های مختلف ارائه شده است. در این شکل سوتون با سرعت

و  Cو  A ،Bاول، دوم و سوووم بووه ترتیووب نتووایج نمونووه 

های قرمز، آبی و سبز به ترتیوب مربوو  بوه نتوایج منحنی

باشود. موی Hydraulic Toolboxو  Image Jآزموون الوک، 

شوود در عموده شورایط هیودرولیکی جریوان، مشاهده موی

بوه منحنوی  Image Jافوزار از نورم ناشیبندی منحنی دانه

بنودی بندی الک نزدیک بوده و در مقابل منحنوی دانوهدانه

، اخت ف زیوادی بوا منحنوی Hydraulic Toolboxافزار نرم

 دارد.  Image Jافزار الک و منحنی نرم

از  ناشوویمتووری نتووایج سووانتی 8در عمووق  Aی در نمونووه

از الوک  ناشیخطای بسیار کمی با نتایج  Image Jافزار نرم

ها میانگین خطای مطلق نسبی دانهکه در ریزطوریهدارد. ب

ی شوود. در نمونوهمشاهده می %2ها دانهولی در درشت  9%

B  دانوه مقدار میوانگین خطوا در بخوش ریزدانوه و درشوت

تواند ناشوی از پوایین بوودن یکسان است. دلیل این امر می

مقدار انحراف معیار این نمونه نسوبت بوه دو نمونوه دیگور 

متوری بورای سوانتی  8باشد. مقدار میانگین خطا در عموق  

دسوت آمود. هب  %12دانه  و برای درشت  %14ها برابر  ریزدانه

 8میوووانگین خطوووای نسوووبی در عموووق  Cی در نمونوووه

 %14و درشت دانه برابر    %9متری برای ریزدانه برابر  سانتی

توان بیان کرد هرچه مقودار دست آمد. در حالت کلی میهب

ضریب یکنواختی نمونه کمتر باشد، مقدار خطوا در بخوش 

هرچوه  سوی دیگراست. از  دانه کمتر شده  ریزدانه و درشت

انحراف معیار کمتر باشد، مقدار خطا بیشتر خواهد بود. در 

انحراف از معیوار نتوایج آزموون الوک و   مقدارهای  1جدول  

نشان داده شده است.  Image Jافزار انحراف معیار نتایج نرم

افوزار کلی با توجه به دقت مناسوب نورمبندی  در یک جمع

Image J افزار بندی، نتایج این نرمدر استخراج منحنی دانه

بووه عنوووان مبنووای کووار در نظوور گرفتووه شوود و در ادامووه 

 افزار ارائه شده است.قطرهای شاخص این نرم  Kمقدارهای  
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Fig. 8 The results of Sieve, Hydraulic Toolbox and Image J at depth of 8 cm with different flow velocities 
 

 

 
Fig. 8 The results of Sieve, Hydraulic Toolbox and Image J at depth of 8 cm with different flow velocities 

های مختلفمتر با سرعت جریانسانتی  8عمق  در    Image Jو    Hydraulic Toolbox،  الکناشی از    جینتا  8شکل 
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 Image Jافزار  مقدارهای انحراف معیار ناشی از آزمون الک و نرم  1جدول 
Table 1 The standard deviation values obtained from the sieve test and Image J software 

Sample 

Standard 

deviation 

of sieve 

Standard 

deviation of 
Image J 

Sample 
Standard 

deviation 

of sieve 

Standard 

deviation of 
Image J 

Sample 
Standard 

deviation 

of sieve 

Standard 

deviation of 
Image J 

A-04-00 

1.68  

1.8353 B-04-00 

1.61 

1.7451 C-04-00 

1.91 

1.8708 

A-04-01 1.8378 B-04-01 1.8027 C-04-01 1.7175 

A-04-02 1.8126 B-04-02 1.7182 C-04-02 1.6475 

A-04-03 1.7842 B-04-03 1.7994 C-04-03 1.7320 

A-08-00 1.8210 B-08-00 1.8496 C-08-00 1.7149 

A-08-01 1.8650 B-08-01 1.7580 C-08-01 1.8209 

A-08-02 1.8210 B-08-02 1.8384 C-08-02 1.7349 

A-08-03 1.8027 B-08-03 1.8165 C-08-03 1.7471 

A-12-00 1.7861 B-12-00 1.7320 C-12-00 1.8629 

A-12-01 1.8122 B-12-01 1.8210 C-12-01 1.7320 

A-12-02 1.8637 B-12-02 1.7986 C-12-02 1.7471 

A-12-03 1.8496 B-12-03 1.8918 C-12-03 1.7600 

 

تههاثیر سههرعت و عمههق جریههان بههر روی  -2-3

   %50قطر شاخص   Kمقدارهای  

 تاثیر سرعت جریان  

تواثیر سورعت جریوان بور روی   11و    10،  9هوای  در شکل

در سه عمق موورد بررسوی   %50قطر شاخص    Kمقدارهای  

ارائوه شوده اسوت. در ایون  A , B , Cی بورای سوه نمونوه

بعود صوورت بویها محور افقی مقدارهای سورعت بوهشکل

(V/Vc)    و محور عمودی مقودارهایK    50قطور شواخص% 

شوود کوه سورعت جریوان بور روی باشد. مشواهده مویمی

تواثیر محسوسوی نودارد.  %50قطور شواخص  K مقدارهای

در   Kمتر میانگین مقودارهای  سانتی  4که در عمق  طوریبه

 08/1و  19/1و  01/1بووه ترتیووب  A , B , Cی نمونووه

 باشد.  می

بوورای  Kقوودارهای متوور، مسووانتی 8هم نووین در عمووق 

و  12/1و  05/1ترتیب برابر است با به A , B , Cهای نمونه

و   08/1ترتیوب برابور بوا  متر، بهسانتی  12و در عمق    11/1

شوود باشد. بنابر این نتوایج مشواهده مویمی  13/1و    18/1

 12و  8و  4در هوور سووه عمووق  Aنمونووه  Kمقوودارهای 

تر است. در عموق دیگر پایین  متر نسبت به دو نمونهسانتی

هوای در سورعت Cو  Bنمونوه    Kمتری مقدارهای  سانتی  8

مختلووف تاحوودودی روی هووم منطبووق اسووت. هم نووین 

متر نسبت سانتی 12و  4در دو عمق    Cنمونه    Kمقدارهای  

 کمتر است.   Bنمونه   Kبه مقدارهای  

 

 تاثیر عمق جریان   -3-3
تاثیر تغییر عموق جریوان بوه   14و    13و    12های  در شکل

قطر شاخص   Kهای مختلف بر روی مقدارهای  ازای سرعت

نشوان داده شوده اسوت.  A , B , Cی برای سه نمونه 50%

محسوسوی بور بنابر نتایج، در هر نمونه عمق جریان تواثیر  

 Kقطر شاخص نداشته و مقدارهای میوانگین  Kروی مقدار  

به  12و  8، 4در سه عمق  Aبرای نمونه  %50قطر شاخص  

(  046/1)با مقودار میوانگین    08/1و    05/1،    01/1ترتیب  

)بوا مقودار   18/1و    12/1،  19/1بوه ترتیوب    Bبرای نمونه  

و   11/1،  08/1بوه ترتیوب    C( و برای نمونه  16/1میانگین  

 1/1باشد )با میانگین کل  ( می1/1)با مقدار میانگین    13/1

ی بوی اثور بوودن هر سه نمونه(. این نتیجه نشوان دهنوده

پدیوده شکسوت نووور در نتوایج تصووویرهای تهیوه شووده در 

باشد. با توجه بوه اینکوه تصوویرها بوا های مختلف میعمق

درجه از یک صفحه افقوی بوا ابعواد کوچوک   90زاویه دید  

متر( تهیه شده است، با افوزایش عموق اثور سانتی  20×20)

زاویه شکست نور در تصویر تهیه شده ناچیز اسوت. شوایان 

 %50قطر شاخص    K، مقدارهای  Aیادآوری است در نمونه  

دهد  و ایون با افزایش عمق جریان افزایش جزئی نشان می

تور اسوت. ایون افزایش در مقدارهای سرعت کم، محسوس
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نیز تا حدودی مشاهده شده اسوت، اموا   Bشرایط در نمونه  

هر سه عموق تاحودودی بورهم   Kهای  منحنی  Cدر نمونه  

های ضریب یکنوواختی، فراسنجه  Cمنطبق است. در نمونه  

طوور هنسبت به دو نمونه دیگر ب  انحراف معیار و جورشدگی

محسوسی بیشتر است  به عبارت دیگر این نمونه نسبت به 

 این    در طرفی   دارد. از  دو نمونه دیگر یکنواختی کمتری 

 

 
Fig. 9 The effect of flow velocity on the value of K at a 

depth of 4 cm at index diameter of 50% 

متر  سانتی  4در عمق    Kتاثیر سرعت جریان بر مقدار   9شکل 

 %50در قطر شاخص  

 
Fig. 10 The effect of flow velocity on the value of K at a 

depth of 8 cm at index diameter of 50% 

متر  سانتی  8در عمق    Kتاثیر سرعت جریان بر مقدار   10شکل 

 %50در قطر شاخص  

 
Fig. 11 The effect of flow velocity on the value of K at a 

depth of 12 cm at index diameter of 50% 

متر  سانتی  12در عمق    Kتاثیر سرعت جریان بر مقدار   11شکل 

 %50در قطر شاخص  

 
Fig. 12 The effect of flow depth on the K value of the 

index diameter of 50% in sample A 

در    %50قطر شاخص    Kتاثیر عمق جریان بر مقدار    12شکل 

   Aنمونه  
 

 
Fig. 13 The effect of flow depth on the K value of the 

index diameter of 50% in sample B 

در   %50قطر شاخص    Kتاثیر عمق جریان بر مقدار   13شکل 

   Bنمونه  

 

 
Fig. 14 The effect of flow depth on the K value of the 

index diameter of 50% in sample C 

در   %50قطر شاخص    Kتاثیر عمق جریان بر مقدار   14شکل 

   Cنمونه  

و کووچکتر نسوبت   %50قطرهای شاخص    هایاندازهنمونه  

 به دو نمونه دیگر ریزتر است.
 

 خطای مطلق نسبی و ضریب همبستگی  -4-3

های مختلفها و سرعتخطا در حالت تر با عمق  مقدارهای
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بیان شده است. میانگین خطای مطلق نمونوه   2در جدول   

A    و در   %9متری، در بخش ریزدانوه  سانتی  8و    4در عمق

متوری نیوز در سوانتی  12، در عموق  %2دانوه  بخش درشت

 مقدارهادست آمد. این  هب  %3دانه  و در درشت  %11ریزدانه  

 %14متر،  سانتی  4برای عمق    %13به ترتیب    Bبرای نمونه  

و   8دانه در عمق  مربو  به درشت  %12مربو  به ریزدانه و  

برای درشوت دانوه در   %14برای ریزدانه و    %17  مقدارهای

نیز میوانگین   Cمتر مشاهده شد. در نمونه  سانتی  12عمق  

و در   %8هوا برابور بوا  در ریزدانوه  4خطای مربو  به عموق  

متوری خطوای سانتی 8، در عمق %13ها برابر با  دانهدرشت

و در عموق   %14و درشت دانه برابور بوا    %9ریزدانه برابر با  

و   %9خطوای ریزدانوه برابور بوا    مقدارهایمتری  سانتی  12

ضوریب   مقودارهایدسوت آمود.  هب  %14دانه برابر با  درشت

 دست آمد.هب 1ها نزدیک نمونه یهمه همبستگی برای

 شکل عاملنتایج   -5-3

شوکل   عامولتاثیر عمق و سرعت جریوان بور    15  در شکل

بورای  Image Jافوزار از پردازش تصویر در نورم ناشینتایج 

ارائه شده است. قسمت افقی نمودار  A , B , Cی سه نمونه

متور( و سانتی 12متر تا سانتی  4مربو  به عمق جریان )از  

ها به ترتیب از چو  بوه راسوت مربوو  بوه جریوان ستون

باشود. در ساکن، جریان با اولین دبی توا آخورین دبوی موی

هوا بستر رودخانوه و در حالوت خشوک، بوا بررسوی نمونوه

صوورت همشاهده شود عموده ذرات موجوود در رودخانوه بو

هووا و عمووق یهمووه در Aمسووتطیلی هسووتند. در نمونووه 

طوور تقریبوی ههوا بوها، درصد شکل مستطیلی دانهسرعت

( و اخوت ف نواچیزی %85 میوانگینطور هباهم برابر بوده )ب

درصوود شووکل  مقوودارهای Cو  Bبوواهم دارنوود. در نمونووه 

ها در حالت جریان ساکن، نسبت بوه حالوت مستطیلی دانه

جریان متحر  بیشتر تشخیص داده شده اسوت. از طرفوی 

در هر سوه عموق، بوا افوزایش سورعت جریوان   Bدر نمونه  

ها کواهش جزئوی را درصد شکل مستطیلی دانه  مقدارهای

رسویده   %70بوه حودود    %80که از  طوریهدهد، بنشان می

در بوالاترین   Bمتور نمونوه  سوانتی  12و    8است. در عموق  

عکوس  Cبرقرار نیست. در نمونوه  بالاسرعت جریان، رابطه  

که با افزایش عموق طوریهاین حالت مشاهده شده است، ب

بوه حودود  %80جریان، مقدار درصود شوکل مسوتطیلی از 

 دهد.  افزایش نشان می 90%

 

 نتیجه گیری -4
عمق و سورعت   ریتاثدر این تحقیق به صورت آزمایشگاهی  

بستر   یسطحهای  و شکل ذرات رسوب  یبندبر دانه  انیجر

)دو   ریبا استفاده از روش پوردازش تصوو  یشن  یهارودخانه

. شودی ابیوارز( Hydraulic Toolboxو  Image Jافوزار نورم

 شود: خ صه نتایج این تحقیق به صورت زیر ارائه می

 رودبرداشت شوده از بسوتر رودخانوه زنجوان یهانمونه •

 شون  نووع  از  متحود،  الاتیوا  یبندطبقه  سامانه  مبنایبر

 A  ینمونه  به  نسبت  یزتریر  یبنددانه  C  نمونه.  هستند

از   شترینمونه باین  در    اریانحراف مع  مقدارو    داشت  Bو  

 . بود  Bو   A ینمونه

بنودی در عمده شرایط هیدرولیکی جریان، منحنی دانوه •

بنودی الوک بوه منحنوی دانوه Image Jافزار از نرم ناشی

افوزار بنودی نورمدانوهنزدیک بوود و در مقابول منحنوی  

Hydraulic Toolbox اخت ف زیادی با منحنی الوک و ،

بنودی داشت. در یوک جموع  Image Jافزار منحنی نرم

در  Image Jافوزار توجوه بوه دقوت مناسوب نورمکلی با 

افزار به عنووان بندی، نتایج این نرماستخراج منحنی دانه

قطرهوای   Kمبنای کار در نظر گرفته شود و مقودارهای  

 افزار استخراج شد.شاخص این نرم

 %50قطور شواخص    K  مقدارهای  یرو  بر  انیجر  سرعت •

 کوهشود  مشواهده    جینتوا  بنوابر  .نداشت  یمحسوس  ریتاث

 12و  8و  4در هوور سووه عمووق  Aنمونووه  Kمقوودارهای 

 در.  اسوت  تورنییپوا  گورید  نمونه  دو  به  نسبت  متریسانت

در  Cو  Bنمونووه  Kمقوودارهای  یمتووریسووانت 8 عمووق

 نی. هم نوبوودهوم منطبوق    یمختلوف رو  یهاسرعت

 متوریسوانت 12و  4در دو عموق  Cنمونوه   Kمقدارهای  

 . بودکمتر   Bنمونه   Kنسبت به مقدارهای  

 شیبوا افوزا %50قطر شاخص   Kمقدارهای    ،Aدر نمونه   •

 در  شیافوزا  نیوا  و  دادنشان    یجزئ  شیافزا  انیعمق جر

در  طیشورا نیو. ابوود  ترمحسوس  کم،  سرعت  مقدارهای

 Cمشواهده شود، اموا در نمونوه    یتا حدود  زین  Bنمونه  

 . بودبرهم منطبق   ودیتاحدهر سه عمق   K  یهایمنحن
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انحوراف   ،یکنوواختی  بیضور  یهوافراسنجه  Cدر نمونه   •

طوور هبو  گورینسبت بوه دو نمونوه د  یو جورشدگ  اریمع

نمونه نسبت به  نیا گری  به عبارت دبود  شتریمحسوس ب

در   ی. از طرفوداشوت  یکمتور  یکنواختی  گریدو نمونه د

و کووچکتر   %50شواخص    یقطرها  مقدارهاینمونه    نیا

  .بود زتریر گرینسبت به دو نمونه د

در هر سه نمونه درصد شکل غالب مستطیلی بود )بیش  •

هووا و ی عمووقهمووه در Aدرصوود(. در نمونووه  70از 

هوا بطوور تقریبوی ها، درصد شکل مستطیلی دانهسرعت

(. از طرفوی در %85  میوانگینطوور  هباهم برابر بودند )بو

در هر سوه عموق، بوا افوزایش سورعت جریوان   Bنمونه  

ها کواهش جزئوی درصد شکل مستطیلی دانه  مقدارهای

کواهش  %70به حودود  %80که از  طوریهرا نشان داد، ب

عکس این حالت مشاهده شده اسوت،   Cیافت. در نمونه  

کوه بوا افوزایش عموق جریوان، درصود شوکل طووریهب

 افزایش نشان داد. %90به حدود   %80مستطیلی از 

 

 نتایج خطای مطلق نسبی و ضریب همبستگی  2جدول 

Table 2 Results of relative absolute error and correlation coefficient 
C B A  

C-

12 C-08 C-04 B-12 B-08 B-04 A-12 A-08 A-04  

1 0.996 0.998 0.996 0.998 0.998 0.996 0.997 0.995 Correlation coefficient 

9 9 8 17 14 13 11 9 9 RAE of fine grains (%) 

14 14 13 14 12 13 3 2 2 RAE of coarse grains (%) 

 

   
 

 
Fig. 15 Percentage of rectangular shape of grains in three samples A, B and C 

 Cو    A  ،Bدرصد شکل مستطیلی ذرات در سه نمونه   15شکل 
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